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Micro Focus Visual COBOL 9.0 for Visual
Studio Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus Customer Support Documentation
Web site for any documentation updates.

Product Overview

Visual COBOL enables you to develop COBOL applications within Microsoft Visual Studio. You use the
Visual Studio integrated development environment (IDE) to edit, compile and debug COBOL applications.
The IDE provides all the functionality to manage projects and build applications.

The product is available in the following variants - Visual COBOL for Visual Studio 2022. The execution
environment for applications created with any of these product variants is COBOL Server.

Upgrading from earlier Micro Focus products

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier
Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0
might not be compatible with the current version of the run-time products. If the behavior of your application
changes with the current version, we strongly recommend that you relink the main executable with the
current version. This will ensure that the COBOL run-time system fully handles any run-time error
conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the
application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance
enhancements, we recommend a full recompilation of your source code.

If you are using Visual Studio, you can configure the IDE to automatically check whether applications
created with older releases must be relinked. If the application uses an older version of the C run-time
system, Visual COBOL can automatically relink the existing executable or .dll to the new version of the C
run-time system without the need to recompile the application first. If a project needs relinking, Visual
Studio displays a message in the status bar providing an option for you to choose and relink the project.
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What's New
Enhancements are available in the following areas:

• Learn Micro Focus™ Learn COBOL extension and Micro Focus™ COBOL Fundamentals Course
• Micro Focus COBOL Extension for Visual Studio Code
• .NET Support
• COBOL Language
• Compiler Directives
• Data Modernization Advice
• Database Connectors for Visual COBOL
• Debugging
• Enterprise Server
• Enterprise Server Common Web Administration (ESCWA)
• Enterprise Server Security
• Interface Mapping Toolkit
• Visual Studio Integration

Learn Micro Focus™ COBOL Extension for Visual Studio
Code and Micro Focus™ COBOL Fundamentals Course

Back to Top

Micro Focus has released a new video-based training course in COBOL, Micro Focus™ COBOL
Fundamentals Course. The course teaches the fundamentals of the COBOL language, introduces the
Micro Focus™ COBOL syntax, and usage of Micro Focus COBOL tools.

The course is ideal for developers familiar with C, Java, or .NET who want to learn COBOL. It doesn't
matter what language you know, as long as you have experience of standard programming concepts, this
course is for you.

A new Learn Micro Focus™ COBOL Extension for Visual Studio Code is available. The extension comes
with the training materials for the COBOL training course. For information about the COBOL course, and
the Learn Micro Focus™ COBOL Extension for Visual Studio Code, visit www.cobol.com.

Note: This extension is not included with the Visual COBOL installer.

Micro Focus™ COBOL Extension for Visual Studio Code
Back to Top

The following features are now available in the Micro Focus™ COBOL Extension for Visual Studio Code
when you use it with Visual COBOL 9.0:

• JVM COBOL debugging
• COBOL notebooks where you can have text and executable blocks of COBOL code in the same file.
• Colorization for COBOL directives files, cobol.dir.
• A new button, , Debug COBOL Program or Run COBOL Program in the top right corner of the

editor, present for the current COBOL program.
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• Configuration setting for custom tab stops.
• A Micro Focus COBOL terminal in the TERMINAL pane.
• You can now specify the COBOL main file context for copybooks if a copybooks is referenced in more

than one program.

Note: This extension is not included with the Visual COBOL installer.

.NET Support
Back to Top

This release provides the following enhancements to .NET support:

• This release installs several NuGet packages each of which contains the assemblies for a specific Micro
Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0 are linked to a
core package, MicroFocus.COBOL.Runtime.Core, that includes the basic functionality for the projects.
You need to add any additional packages (such as a specific file handler, COBOL Accept/Display etc.)
manually to the projects. The new packages enable better granularity of distributions, and provide more
flexibility and control over what is packaged with the application.

• New SDK version - the Micro Focus SDK version has changed to version 2.1. See Upgrading
existing .NET COBOL project files in your product Help for details on how to upgrade your existing
projects.

COBOL Language
Back to Top

This release provides the following new features and enhancements to the COBOL language:

• Double-colon, ::, qualification is now available as a qualifier for data names and when dereferencing
pointers.

• PERFORM frame local variables - variables that are DECLAREd are now properly scoped. Reentering
the SECTION, whether recursively or after leaving, gives a new instance of such variables. This
provides better locality of data, and helps with writing of better structured code.

• Parameterized sections - syntax that allows program sections to accept arguments and return values.

• PERFORM of a SECTION can now pass arguments to that SECTION.
• A result can be returned to the code that PERFORMed the SECTION.
• Sections that return a value can be used as functions, in contexts where an identifier is expected.

• Compiler can identify platform at compile time - the compile-time constants __unix, __windows,
__dotnet, __jvm, and __native have been introduced. These can be tested in $if statements to
tailor code to the platform being used.

• Enhanced CBL_STRING_CONVERT library routine - CBL_STRING_CONVERT can now convert
strings to and from Base64.

The following enhancements add further support for the IBM Enterprise COBOL version 6.4:

• User-defined functions - user-defined functions are now available in an Enterprise COBOL dialect for
version 6.4 compatibility. Reference the product Help, General Reference > COBOL Language
Reference > Part 3. Additional Topics > Additional Dialect Support > Enterprise COBOL Syntax Support
> User-Defined Functions under ENTCOBOL dialect. A new Compiler directive, MANAGED-FNC-
PARAM-BY, enables you to specify whether the managed behavior of numeric function parameters
should default to BY VALUE or BY REFERENCE.

• Enhanced mechanism for interoperation between Java and COBOL - The COBOL and Java
interoperability has been enhanced to extend the capabilities of your COBOL applications with Java. It
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removes the need to write object-oriented (OO) COBOL, as your native COBOL and Java programs can
now interoperate in the following scenarios:

• COBOL programs can be marked as JAVA-CALLABLE, meaning that they can be called from Java
as though they were Java static methods.

• COBOL program can call Java static methods using the java.class.method call.
• COBOL data can be shared with Java programs by marking it as JAVA-SHAREABLE.

• Comprehensive support for automatic conversion between a wide variety of popular Java data types
and their corresponding COBOL types so that parameter passing and returned value handling require
no special processing in user code.

Compiler Directives
Back to Top

This release provides the following enhancements.

A new mechanism for setting Compiler directives (Technology Preview):

• Common directives files - this release introduces common directives files, directives.mf files, that
enable you to automatically provide all required directives needed to compile multiple COBOL
applications without having to specify the directives individually. This feature is not available for
Assembler or IMS.

Note: This is a technology preview feature only. It is being made available to allow you to test and
provide feedback on this new capability; however, this feature is not intended for production use
and it is not supported as such. Furthermore, Micro Focus does not guarantee that this feature will
be delivered at a GA level and if it is, then the functionality provided might differ considerably from
this technology preview.

New Compiler directives:

• ALPHA-LIT-CONT - determines whether the right margin or the end-of-line is used to delimit the
continuation of a non-numeric literal.

• DECLARE - defines the behavior of locally declared variables.
• ILEXPOSEALPHA/ILEXPOSEGROUP - these two directives can expose alphanumeric or group items

passed by value to parameterized sections or methods in .NET COBOL programs as byte arrays (the
default is to expose as string objects).

• ILSTRINGLOAD - where .NET COBOL programs with a very large number of distinct alphanumeric
literals cause internal limits to be exceeded, use this directive to create these literals in a backing file,
which can then be converted to strings at run time.

• MANAGED-FNC-PARAM-BY - determines whether user-defined function parameters are passed BY
VALUE or BY REFERENCE by default when compiled with ILGEN.

• INITIAL - determines how Working-Storage is initialized for programs marked as IS INITIAL.

A family of new Compiler directives has been introduced to support the new mechanism for interoperation
between Java and native COBOL:

• JAVA-SHAREABLE - use the JAVA-SHAREABLE ON and JAVA-SHAREABLE OFF directives to bracket
one or more WORKING-STORAGE data items to indicate that they are to be made read and write
accessible from Java applications interoperating with this COBOL program.

• JAVA-CALLABLE - instructs the Compiler to make the COBOL program automatically callable from
Java.

• JAVA-GEN-PROGS, JAVA-GEN-STRG, JAVA-OUTPUT-PATH, and JAVA-PACKAGE-NAME - control the
behavior of COBOL programs that interoperate with Java through the JAVA-CALLABLE or JAVA-
SHAREABLE directives or by calling Java static methods using the CALL statement.
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Data Modernization Advice
Back to Top

The product Help now includes advice on moving your COBOL data files, such as flat files, VSAM, indexed
or sequential files, etc. to a relational database (RDBMS). The documentation lists the solutions included in
Visual COBOL that enable you to achieve this, including advice on the best option for your application as
well as performance considerations.

Database Connectors for Visual COBOL
Back to Top

This release provides the following enhancements:

• Better control of permissions granted on newly created tables.

When creating a table, the SQL Server interface also creates an index, and grants loose permissions to
everyone via the A-MSSQL-GRANT-PERMISSIONS and A-MSSQL-GRANT-USERNAME configuration
variables with their default values. If database permissions are not set to allow these loose permissions,
the GRANT statement fails, causing OPEN OUTPUT to fail.

See A-MSSQL-GRANT-PERMISSIONS and A-MSSQL-GRANT-USERNAME for details.
• Increased table and column name sizes for ODBC

To accommodate the number of characters the ODBC driver allows, this release increases the allowable
table name and column name sizes for ODBC via two new ODBC configuration file variables. For
details, see A_ODBC_MAX_COLUMNNAME_LEN and A_ODBC_MAX_TABLENAME_LEN.

• Support for all currently available versions of the MIcrosoft SQL Server ODBC Driver, which have been
tested through version 18.

See the following Configuration Variables topics for details:

A_MSSQL_ODBC_DRIVER_NAME
A_MSSQL_ENCRYPT_CONNECTION
A_MSSQL_TRUST_SERVER_CERTIFICATE
A_MSSQL_EXTRA_CONNECTION_INFO

• The A_MSSQL_IDENTITY_TYPE configuration variable has been added to enable you to configure the
identity column to be a larger type, and to store a 64-bit value internally. Set
A_MSSQL_IDENTITY_TYPE to a string value that represents a fully qualified data type for your
database. The default is:

 A_MSSQL_IDENTITY_TYPE="numeric(9,0)"

Debugging
Back to Top

This release provides the following new feature:

• In Visual Studio, you can now debug .NET COBOL projects in WSL.

Enterprise Server
Back to Top

8 | What's New



This release provides the following enhancements:

• A new casverify command-line utility is available. This utility enables you to verify the configuration of
a specified enterprise server region without attempting to start it, and also enables you to create
immediate diagnostics information in JSON or human-readable output. Verification stages are modular,
enabling you to specify which validation checks to run.

• You can now list job steps to enable users to perform advanced restarts. Job steps can be output to
JSON by specifying casout /%jnumber or output to a table by specifying casout /%tnumber. See
casout for more information.

Enterprise Server Common Web Administration (ESCWA)
Back to Top

Enhancements are available in the following areas:

• Accessibility improvements - provide improved compliance with 508 and WCAG 2.1 standards.
• API, version 2 extensions - includes updated versions of some of the existing API version 1 endpoints,

and has been extended to contain more endpoints.
• Merged Archived Spool - you can now configure an enterprise server region to view a merged archived

spool in the UI. You can view multiple archived spools from a single region, and view old spool
information for multiple jobs that have ran under a previous name

• Page search facility - you can now search for a page that contains a specified search string. This
enhancement is part of the WCAG 2.1 requirements for accessibility.

• PAC clients - the ESCWA UI lists all TN3270 clients connected to a PAC. This enables you to administer
and monitor clients across the entire PAC from a single PAC region.

• TLS-enabled Redis connections. ESCWA now supports administering and monitoring PACs with a TLS
Redis SOR.

Enterprise Server Security
Back to Top

This release provides the following new features and enhancements:

• Demo CA - the component has been completely redesigned and is now included as part of Visual
COBOL. Demo CA supports multiple installations, uses up-to-date cryptographic support, and
generates modern version 3 certificates with SANS, PKIDs, AKIDs, etc. signed by an intermediate CA.
Demo CA is now easier to use and has improved interoperability with third-party SSL/TLS systems.

Note: Micro Focus strongly recommends that Demo CA is only used for SSL/TLS development
and testing and is not intended for use in a production environment.

• esfupdate support for the Vault Facility - the esfupdate utility now supports the use of the Vault
Facility for credentials it needs to connect to MFDS.

• OpenSSL 3.0 - OpenSSL has been updated to use the current Long Term Supported OpenSSL
cryptographic library.

• VSAM External Security Manager (EAP) - the VSAM ESM Module is a new option for Enterprise Server
security which is simpler and more convenient than using LDAP-based security. The VSAM ESM
Module provides a security manager for Enterprise Server which keeps security data in COBOL data
(VSAM) files. It provides many of the features of the MLDAP ESM Module but does not require an LDAP
server or other third-party solution. Security data can be imported from a YAML file, facilitating the
securing of Enterprise Server and the modification of its security data.
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Attention: This feature is in Early Adopter Program (EAP) release status. We intend to provide the
finalized feature in a future release. Please contact Micro Focus Customer Care if you require
further clarification.

HCO for SQL Server
Back to Top

This release includes support for the following:

• The Define Lists tool in the HCOSS UI has been enhanced to enable you to select a dependency mode
to use when creating a transfer list. The available modes are:

Default Automatically include all parent objects of the selected object.

Family tree Automatically include all parent objects of the selected table.

Automatically include the child objects of each parent object.

Repeat until no more parents and children are found.

No dependency handling Include the selected table only (do not include any parent or child objects).

• The Transfer Data Tool now includes the start and end date and time for each table transfer.

Interface Mapping Toolkit
Back to Top

This release provides the following enhancements:

• YAML support is now available for COBOL client generation. OpenAPI schemas can now be in YAML, in
addition to JSON format.

• The Interface Mapper user interface for COBOL program-based service interfaces has been updated.
The Interface Fields pane available in earlier versions is now represented by two panes — Interface
Fields - Input and Interface Fields - Output. The COBOL Entry Points pane is situated between
these two new panes. The relationships between COBOL entry points and corresponding interface,
COBOL assignment, and reusable fields are depicted visually using arrows. The panes can be
repositioned for easier viewing of arrow relationships.

Visual Studio
Back to Top

This release provides the following new features:

• Converting JSON data to COBOL classes - you can now copy JSON data and use the Paste JSON As
Classes command to copy it into a .NET COBOL file. This generates COBOL classes that enable you
to deserialize the data in those classes.

• Document Outline window for COBOL files.
• Editor support is available for local variables and parameterized sections.
• Format with code cleanup can now be configured to change any keywords in your code to lowercase or

uppercase.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• .NET Support
• Compiler
• Data Tools
• Documentation
• Enterprise Server
• File Handling
• Micro Focus Directory Server
• Runtime System
• Setup Issues (Windows)
• Visual Studio IDE

.NET Support

Back to the list

• The 9.0 release installs several .NET 6 NuGet packages each of which contains the assemblies for a
specific Micro Focus functionality. New .NET projects, as well as existing projects you edit or build in 9.0
are linked to a core package, MicroFocus.COBOL.Runtime.Core, that includes the basic
functionality for the projects. You need to add any additional packages (such as a specific file handler,
COBOL Accept/Display etc.) manually to the projects.

Building existing .NET COBOL projects created prior to 9.0 might result in build errors. You can ensure
compatibility by enabling the use of the MicroFocus.COBOL.Runtime metapackage. Alternatively,
you need to add any required NuGet packages manually to the older projects.

See Upgrading existing .NET COBOL project files in the product Help for details on how to upgrade.

Compiler

Back to the list

• Preprocessor options of more than 256 bytes are now supported, and no longer cause the Compiler to
crash.

02289875 02308713 (272069)

Data Tools

Back to the list

• A new print function available from the File group and the File menu enables you to print the records
shown in the editor.

00367084 (12432)
• An enhancement to the Compare Files function has been added, so that when a comparison is made,

the File Information option shows a statistics overview of the comparison being displayed.

02200177 (222157)
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• In the Data File Editor, the Compare Files function has been enhanced to allow you to select start and
end columns in which to compare, so only a subset of a record is compared, rather than the entire
record.

02306654 (222159)
• A Quick final page access option has been added to the Preferences dialog box of the Data File

Editor. When selected, large variable sequential files (files > 10,000 records) immediately jump to the
last page of the file when it is opened.

02330923 02365033 02399254 (294002)

Documentation

Back to the list

• To correct an error that sometimes occurred when generating IMTK clients, you must install the latest
version of the Visual Studio MSVS Workload > C++ x64/x86 component. 

(400031)

Enterprise Server

Back to the list

• A new option to uninstall a PAC installed on an enterprise server region before deleting the region has
been added to ensure that all PAC components are properly removed.

01907370 (124107)
• ESCWA now validates the TLS properties to help prevent errors on entry.

Note: If ESCWA has an invalid TLS configuration, it reverts to starting without TLS enabled.

01983736 (203178)
• In ESCWA, a Stop for IMS MPRs, JES Initiators, and JES Printers now operates correctly.

02311796 (286178)
• An issue with not being able to update or navigate the ESCWA UO though the job output in the spool

while it is still running has been resolved.

02322494 (286142)
• In ESCWA, the default dashboard can now be modified for all users of a server.

02458710 (392040)
• In ESCWA, the FCT Fix Up button has been added to the Active FCT page. See Active FCT in your

product Help for more information.

(374021)
• The Job View page in ESCWA now includes a list of job steps that have run during the current

enterprise server region up time.

(347033)
• A new configuration property has been added to ESCWA to enable the default language the UI displays

to be overridden from the user's browser locale.

02227239 02307446 (260128)
• ESCWA now supports TLS enabled Redis repositories.

(306097)
• In ESCWA, the Process ID column has been added to the table on the Dynamic Debug page. See

Dynamic Debug in your product Help for more information.

(350029)
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• In ESCWA, a new PAC Client List page has been added. This page displays a list of PAC members
and associated information. See PAC Client List in your product Help for more information.

(384037)
• An alternate index has been added to the non-recoverable temporary storage file TXTSNR. This is to

enable queues to be returned in alphabetical order when browsing with INQUIRE. When warm starting
non-recoverable TS, if TXTSNR has only a single key then the file will automatically be upgraded to
include the alternate index. If there is a problem during the upgrade process then message CASI1405S
will be written to the console indicating the failure and that the enterprise server region will fail to start.
In this case, the file will either need to be repaired or temporary storage will need to be cold started.

Note: Once TXTSNR has been upgraded it can no longer be used on an older version of the
product that does not contain this fix.

02441509 (389045)
• Corrected the spelling for the db_server_name Configuration Manager property. You will need to

update existing 8.0 enterprise server region configurations by either applying any change on the
ESCWA General >Advanced page, or by updating the mfConfigManagerData MFDS property
through the ESCWA API. If this is not performed, the warning message CASCF0071W
Configuration Manager - The requested property (db_sever_name) was not found
will be displayed in the Console log during region initialization. This will not cause any issues if the
Region Database Server Name property was not previously used, or if it was set though the
ES_DB_SERVER environment variable. Otherwise, you will need to reset this property using the above
methods as the previous configuration for Region Database Server Name will not be honored, which
might result in the region failing initialization.

(350050)
• In the context of a multi-hop Distributed Program Linking (DPL), if the last stage used the default mirror

transaction, its back-end could be left hanging if a SYNCPOINT was invoked by the upstream partner.
This has been fixed.

02432614 02434318 (377071)
• You can now list job steps to enable users to perform advanced restarts. Job steps can be outputted to

JSON by casout /%jnumber. Job steps can be output to a table by casout /%tnumber. See
casout in your product Help for more information.

(401023)
• The Redis server supplied with the product is now version 6.2.6.In ESCWA, you must now specify the

Certificate Authority Filepath, Certificate Filepath, and Private Key Filepath properties on the
Advanced Region Properties page for all enterprise server regions that are members of a PAC that
has a TLS-enabled Redis Scale-Out Repository (SOR). See Scale-Out Repositories in your product
Help for more information.

00373756 (12618)
• During XA recovery, if a resource manager reports an in doubt transaction which has no log entry, a

CASXO0040W message will now be displayed in the console.

(425081)
• If a SOR cannot be connected during enterprise server region start up, then the region no longer starts.

Previously, this only applied to the PSOR, but now applies to other SORs which were only used for TS
and TD queues. This change was made because the previous behavior could lead to queues being
written to different locations (SORs or disk) across the PAC. If a PSOR cannot be connected during a
process start up when the region is already running, then the process will be blocked until the
connection can be established. Retries will be attempted at increasingly longer intervals. If a (non-
PSOR) SOR cannot be connected to at process start up when the enterprise server region is already
running, then the process will continue to start up. At queue access time, for a queue that must go to
that SOR, the connection will be retried. If this is unsuccessful then the command will receive an
IOERR.

02399193 (356005)
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• ESMAC is disabled by default. ESMAC can be enabled from the Advanced Region Properties page in
ESCWA.

(397027)

File Handling

Back to the list

• The SQL Server ENQ/DEQ implementation has been modified to eliminate any possibility of ENQ
request failures occurring due to an intermittent Service Broker problem. The new implementation
introduces a new ENQ stored procedure, and modification of the existing DEQ one to allow it to work
with both the Service Broker and non-Service Broker implementations.

(285197)
• The OPEN EXTEND operation now follows the behavior expected from the OPEN statement as

documented.

02454638 (386087)

Micro Focus Directory Server

Back to the list

• The External Security Manager (ESM) checks did not occur when an enterprise server region started or
stopped. This has been fixed.

02402188 (355001)
• To query Enterprise Server security configuration information (details of configured external Security

Managers and so forth) from the Micro Focus Directory Server when access is restricted, the authorized
Enterprise Server user must have at least Read permission for the Enterprise Server Administration
resource class User Administration entity.

(285199)
• Micro Focus Directory Server now restricts access to enterprise server regions that a signed-on user is

not authorized to view.

02305916 (285169)
• Four new MFDS-only audit event codes (2 300, 2 301, 2 302, and 2 303) have been added. See Audit

Event Codes in your product Help for more information.

02412285 (365149)

Run-Time System

Back to the list

• By default, CTF information no longer appears in AUX Trace of an enterprise server region. To enable it,
you now need to set mftrace.emitter.es#level in the MFTRACE_CONFIG.

(328008)
• Previously, .NET COBOL applications that use OpenESQL/ODBC could fail to run with a license error

when deployed to a COBOL Server. This has now been fixed.

02490119 (406153)
• If an error occurs during thread clean-up, the runtime will now attempt thread clean-up again. If it fails

for a second time the runtime will call _exit() to terminate the process immediately.

02286519 (258130)
• Attempting to call COBOL functionality after calling the cobtidy() API, to de-initialise the COBOL

RTS, will now result in a COBRT090 error message.  Previously it was documented that the results
were undefined and it could cause subsequent problems, and/or errors, especially in a threaded
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environment.  The aim of this change is to give a more meaningful error message, earlier, to help
diagnose such issues.

(301136)
• The limit for the MAXGENERATION emitter property (for both BINFILE and TEXTFILE) has been

increased from 10 to 100. The file size limit for each of these generations, as set by the MAXFILESIZE
property, is 1000000KB.

02405466 (359001)

Setup Issues (Windows)

Back to the list

• Micro Focus Host Access for the Cloud emulator replaces the Micro Focus Rumba+ Desktop emulator
previously supplied with the installer for Enterprise Developer for Eclipse or Visual Studio. Customers
that have Rumba+ Desktop entitlement can continue to use it within Rumba+ Desktop.

(335003)
• In Windows 11 it is now possible to open COBOL 32-bit and 64-bit command prompts from the Terminal

application.

(421016)
• On Windows, you must uninstall earlier versions of this product before installing 9.0.

(380028)
• 32-bit Windows is no longer supported.

(382034)

Visual Studio IDE

Back to the list

• In this release, new native COBOL projects in Visual Studio are configured to build on both x86 and x64
platforms. If the project is added to an existing solution, the build target configured for that solution will
be used. For new solutions, the x64 targets are always selected by default. This change in behavior
does not apply to Dialog System projects or imported 32-bit Net Express projects. There are some
known limitations of x64 templates, so users will need to set the correct platform. Some templates
remain 32-bit only.

(409099)
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• An issue with the Call method in the COBOL RunUnit class prevents it from being used when you target
the .NET Framework. A fix is going to be available with Patch Update 1 of this release. This issue does
not affect .NET 6.

• .NET COBOL projects only support Windows and Linux OS. The Create a new project dialog box in
Visual Studio, however, shows other platforms as supported.

• If, after installing the product for Visual Studio 2022, you cannot access the Micro Focus functionality,
execute the following command from a Visual Studio command prompt:

devenv /updateconfiguration

• The Server Core form of Windows Server 2019 is not supported.

• In Visual COBOL 4.0 and 5.0 in an extremely small and limited set of cases, an issue could occur with
running .NET executables and .dll files, or JVM .class files, created with an earlier version of the
product. This issue only occurred if:

1. The application performs an IS NUMERIC condition test on a variable declared with USAGE
NATIONAL.

2. The application has been created with Visual COBOL 3.0 or earlier, then executed in Visual COBOL
4.0 or 5.0.

In these rare cases, the IS NUMERIC test could provide the wrong answer.

In order to resolve this issue, in Visual COBOL 6.0 and later, the .NET COBOL and JVM COBOL run-
times reject any program using IS NUMERIC on a NATIONAL item which was compiled with a version
5.0 or earlier of the product. You receive a "missing method" exception. To resolve the issue, you need
to recompile any programs that use this construct in the newer versions of Visual COBOL.

Program that do not use NATIONAL data, or those that have been recompiled in Visual COBOL 6.0 or
later are not affected.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Defect number (in
parentheses).

• COBOL Language Server
• Code Analysis
• Codeset Support
• Common Communications Interface
• Compiler
• Containers
• Database Connectors for Visual COBOL
• Data Tools
• Debugger
• Dialog System
• Documentation
• Enterprise Server
• File Handling
• Micro Focus Common Client
• Micro Focus Cryptographic Library
• Micro Focus Directory Server
• Micro Focus License Administration
• Run-time System
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: OpenESQL
• Visual Studio IDE
• XML Support

COBOL Language Server

Back to the list

• Some performance issues when requesting workspace symbols in large workspaces have been
resolved. The operation is now limited to files that are open or parsed.

02384141 (338011)

Code Analysis

Back to the list

• MFDASMX no longer crashes when download process is initiated.

02411250 02427959 (363118)

Codeset Support

Back to the list

• The DISJOINING clause now works as expected when a DBCS hyphen is specified as part of the prefix
or suffix.

(296145)
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Common Communications Interface

Back to the list

• A handle leak on failed ISC connection attempts has been fixed.

02413198 (381021)
• TLS connections failed when a trust anchor was not specified. This has been fixed.

02534509 (446004)

Compiler

Back to the list

• An 013-R error generated on compilation has been fixed.

02501331 (401125)
• A new directive, ILSTRINGLOAD, is now available for .NET COBOL programs, which can help in

situations where a program with a very large number of distinct alphanumeric literals causes internal
limits to be exceeded in a class (and at which point, an error is generated). Use the directive to create
these literals in a backing file, which can then be converted to strings at run time.

02170649 (380058)
• A program containing a debug line as its first line of source now compiles with an expected syntax error,

rather than a Compiler crash.

(306070)
• Querying the subordinate items of a group defined in a DECLARE statement now works as expected.

(414100)
• Debugging of a program with a copybook located via COBCPY, where the value of COBCPY is

extremely long, now works as expected.

02298722 (276005)
• Using a PROPERTY as a call parameter now compiles and executes as expected.

(5357)
• A query expansion of OCCURS DEPENDING ON tables now correctly reflects the current size.

02500813 (405134)
• The Outline view in the IDE is now available for all programs, irrespective of syntax errors encountered.

02297623 (285151)
• An ALLOCATE statement RETURNING a subscripted pointer now executes as expected.

(369004)
• An ADD .. TO property statement now executes as expected.

(6503)
• The 'AT END' phrase of a file statement is now correctly distinguished from dereferencing syntax

specified in the same context.

(6149)
• The CP preprocessor now respects the setting of the SOURCE-ENCODING Compiler directive.

02463619 (394012)
• Reference modification with an implicit length on the result of an intrinsic function now executes as

expected.

02269123 (258090)
• A MOVE CORRESPONDING statement with nested subscripting now executes as expected.

02473286 (395097)
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• A background parse of COBOL source containing illegal code and characters before the main COBOL
program now produces full syntax checking consistent with previous releases.

02393247 (352074)
• INSPECT .. REPLACING more-than-one-byte BY SPACE is now producing the expected execution

results.

02521582 (411107)
• The CP preprocessor now correctly expands copybooks when COPY REPLACING is active and the

copybook name partially matches the replacing text.

02541659 (427024)
• A COPY REPLACING statement that results in a replacement line of more than 256 bytes is now

processed as expected.

(301078)
• Programs called with a CHAIN statement, which use their own file handler to access the filename

pointer in the FCD, now execute as expected.

(286017)
• A query of an item in a variable-length group with an UNBOUNDED table now returns the correct value.

02500660 (403177)
• Error message COBCH1554 More than 65535 statements in a paragraph. Cannot

produce debugging information is no longer reported for compilations where debugging
information was not requested (i.e., NOANIM specified).

02525192 (415062)
• A CALL statement using the 'DATA AT' syntax to pass a dereferenced parameter BY REFERENCE now

compiles and executes as expected.

(351091)
• The user responses for the ERRQ Compiler directive are now all respected correctly.

(350010)
• COMP-1 and COMP-2 data types compiled with DIALECT"ACU" now receive a syntax error when a

PICTURE description is absent.

(296032)
• When the LANG environment variable is correctly set to match the source encoding of the COBOL

source file, the Compiler now completes the compile successfully.

(390023)
• The DIALECT"MF" Compiler directive no longer affects the user-specified setting of the SETTING

directive.

02449496 (390008)
• A STRING statement with 'DATA AT' operands now executes as expected.

(260018)
• Level 88s defined in a typedef may now be referenced through pointer dereferencing.

(377067)
• $if syntax is now processed correctly in all cases.

(318040)
• When using a typdef-item at pointer that was not unique in the typedef group, the Compiler compiled

without error; however, the pointer sometimes dereferenced at the incorrect address. This scenario now
produces a COBCH0005-S User-name not unique error message.

(415140)
• The DISPLAY-PICU(UTF-8) option now operates correctly with OUTDD when using Enterprise Server.
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(297005)
• A new Compiler directive, ALPHA-LIT-CONT, determines whether continuation of non-numeric literals

includes spaces up to the right margin, or simply to the end of line.

(380072)
• A DECLARE value can now be expressed as an arithmetic expression in native COBOL.

(386138)
• The INITIALIZE condition-name syntax erroneously compiled without error. This now correctly

returns a syntax error for all scenarios.

02468662 (394064)
• An INSPECT statement used inside a class method no longer causes generation of invalid .NET or JVM

code. (This problem did not apply to procedural COBOL programs.)

02504599 (403183)
• When debugging programs compiled with sourceformat(fixed), attempting to quick-watch

variables with long names, or at a deep level of nesting within a group, could be unsuccessful.  In
addition, hovering over such variables while debugging failed to show the value of the variable. These
issues are now fixed.

02489352 (401187)
• When using named parameters to access a method in a generic class, the Compiler could produce a

spurious system error. This is now fixed.

02418658 (369012)

Containers

Back to the list

• We strongly recommend that you create Micro Focus base product images with the bld.sh script using
the provided Dockerfile/Containerfile. Images created using alternative methods might fail with the
message 245 There are no valid product licenses unless the image includes the
CONTAINER environment variable. This release ensures that the provided Dockerfiles/Containerfiles
include this environment variable.

02555217 (439070)

Database Connectors for Visual COBOL

Back to the list

• When accessing a SQL Server table with Database Connectors, and when the primary key allowed
duplicates (which is not recommended), the interface sometimes incorrectly handled a direct READ,
especially when it was followed by a READ NEXT. This has been corrected.

02336856 (297028)
• The following issues that occurred when a primary key allows duplicates have been fixed:      

Rewriting or deleting a row sometimes affected more than a single row.     
Executing READ followed by READ NEXT returned the wrong record.  

To use this fix, both of the following conditions must be met:

• An identity column must be included. This can be either a hidden column using A-MSSQL-ADD-
IDENTITY when the table is created, or an explicit column using the IDENTIY-COLUMN XFD
directive. 

• The record to update or delete must be the last record read.

Failure to meet either of these conditions results in run-time error code 9/7. See Run-Time System
Errors in your Visual COBOL Database Connectors documentation.
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02324219 (285156)
• All special characters used in a user name or a password must be surrounded by {} brackets. If the }

closing bracket is used as a special character, it must be doubled to escape it. For example:

my{@}user{}}name

Translates to:

my@user}name

02393584 (352036)
• When doing a REWRITE or a DELETE on record that was constructed by the COBOL program (as

opposed to having just READ the record), the wrong record could be affected. This has been corrected.

02497731 (401111)

Data Tools

Back to the list

• The Data Tools editor could display incorrect record numbers for variable sequential files following a
Find operation. This has been fixed.

02516058 (411005)
• In the Data Tools editor, there was an issue with viewing the last page of records in a sequential

variable file when the Quick final page preference setting was enabled and the file was defined with a
minimum record length of 0 or a large variable record size range combined with a large Records per
page preference setting. This has been fixed.

02487096 (397034)
• The performance of the Search > Go To navigation feature of the Data Tools editor has been improved

for variable and line sequential files.

02399254 02480008 (399043)
• Editing/deleting line sequential file records no longer hangs when using Date File Tools.

02239120 (259127)
• When attempting to open data sets in the Data File Editor, file names containing a $ sign are no longer

incorrectly trimmed.

02194216 (221086)
• Data File Tools no longer attempts to open unrecognized file formats. Instead, an error message

appears explaining which format is invalid.

02308449 (281015)
• You can now copy hex values of selected records from the unpacked rows at the bottom of the screen

using the Copy Hex option available on the context menu the Edit menu. This option is visible only
when the hex toggle is enabled.

02396732 (352067)
• When copying a record to an external destination, the NULL Byte character is replaced by a character

specified in the Preferences dialog box. The default replacement character is a period (.).

02396678 (350053)
• The Toggle Hex function now shows hexadecimal values under each line in the editor, not only the

selected one.

02342260 (297080)
• Field values of the Data File Tools File Information dialog box can be selected and copied to clipboard.

02396730 (352047)
• Horizontal scrolling in files with variable-length records did not work as expected when a short record

was selected. This is now fixed.
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02150974 (202028)
• It is now possible to start mfdatatools2 from the command line to open a catalogued file from an

enterprise server region.

00501248 (71267)
• In the Data File Editor, a preference has been added to specify the maximum number of requested data

sets in the Data Explorer view. If a catalog contains more data sets than the maximum requested
number, a More data sets in catalog stub appears at the end of the list.

02396657 (350052)
• You must configure a TS model to ensure that Data File Editor correctly honors file locking across all

enterprise server regions in a PAC.

02529725 (413062)
• Previously, the DFCONV utility would produce an error when converting sql:// database files. This

has been fixed.

02497741 (403103)

Debugger

Back to the list

• Debugging a statement that goes up to column 255, with the Autos window active, now works as
expected.

02289017 (271031)
• Expanding a dereferenced group item in the debugger now correctly shows the data for subordinate

items.

(363158)
• Previously, CBL_DEBUGBREAK did not invoke the debugger in .NET COBOL applications. This has

now been fixed and the built-in "Choose Just-In-Time Debugger" dialog box appears during invocation.

02388923 (348042)
• An issue has been fixed where the list of processes for 'attach to process' debugging could be displayed

incorrectly.

02458536 (386153)

Dialog System

Back to the list

• An issue with the dialog system painter clearing the screen when resizing a control has been resolved.

02367685 (330012)

Documentation

Back to the list

• Enterprise Server security configuration options have been updated. See Security Configuration
Custom Configuration Information in your product Help for more information.

(411024)
• Information on configuring an OpenLDAP server has been updated. See Configuring the OpenLDAP

server in your product Help for more information.

02387889 SF:02437494 02437494 (356021)
• The CASESM Security Manager was part of the legacy security model used in the Net Express and

Server Express 5.0 and earlier products. As part of this, the legacy ESMAC user interface pages had
Security Keys as configurable options. In ESCWA, these can only be accessed by the Client Web API
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and are not available in the ESCWA user interface pages that are equivalent to the corresponding
ESMAC pages.

02276034 (259095)
• The OSESM tracing option has been added to the configuration information in the product Help.

02145921 (202197)
• Setting ES_PRODUCTION=Y will prevent debugging on Enterprise Server regions.

02208272 (346026)
• The documentation sample in the Using CobolBean for Instance Data Java topic has been corrected.

(409036)
• The product documentation has been updated with the current name and contact information for Micro

Focus Customer Care. Any instance of the older terms for customer support remain in the
documentation because it is present within the product itself.

(377012)
• The SQL Server RM Switch Module topic has been updated to remove the [directives] option for build

mssql. The option is not valid and ignored by the system.

3172383 (13152)
• The documentation has been corrected to describe the duplicate cursor effect.

3172533 (11320)
• The product documentation now correctly states PF_RO_CURSOR=8 as default when using

BEHAVIOR=MAINFRAME with SQLServer.

00372417 (12688)
• The documentation has been updated to show that only under an MF dialect can you omit the Working-

Storage Section heading.

3245726 (28060)
• The documentation has been updated to clarify that the paper size is calculated in one-hundreths of an

inch for .NET COBOL programs using the  PC_PRINTER_DEFAULT_PROPERTIES library routine.

(386105)
• The documentation has been updated to clarify support for the following: the CBL_GET_ERROR_INFO

and CBL_CREATE_STACKDUMP library routines, the stackdump_on_error tunable, and the
cobgeterrorinfo function.

(385041)
• The cob command examples in the documentation have been updated.

(403044)
• New documentation has been added that gives more detail on how to use the CBL_CTF_* library

routines. See Using the CTF Library Routines in the product documentation for more information.

(264040)
• The Micro Focus Unit Testing Framework documentation has been updated to explicitly state that the

MFUPP preprocessor is intended for use only within the confines of the testing framework.

02259026 (258085)
• Some of the screen shots in the MFDBFH documentation have been updated to show MFDBFH-

specific URLs in ESCWA.

(301083)

Enterprise Server

Back to the list
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• Now users who have overlapping long names like USER1234 and USER12345 will not have overlapping
permissions when they have distinct mapped short names.

02529441 (440070)
• In Enterprise Server External Security Facility (ESF), requests to generate a passtoken (including for

RACF-style passtickets used by DCAS) could sometimes be rejected as unauthorized attempts to
create surrogate passtokens even though the passtoken request was not for a surrogate. This was due
to a case mismatch between the request and ACEE. This has been fixed.

02433532 02442474 (399097)
• The ESF could corrupt the credentials used to connect to an LDAP server when auditing was enabled,

causing a critical security failure and preventing enterprise server regions from starting. This has been
fixed.

02518028 (415116)
• MLDAP ESM now supports the use of the mfsecret: syntax for retrieving the security manager

credentials (authorized ID and password) from the vault. Those fields in the Security Manager definition
in ESCWA can be specified using the forms:

        mfsecret:configuration-name:secret-path

or:

       mfsecret:secret-path

02548082 02554256 (440042)
• Mfsecrets crashed when running as multithreaded. This has been fixed.

(381004)
• A problem that prevented the AES provider on big-endian platforms from correctly reading vault secrets

has been fixed.

(430032)
• An incorrect signal 11 was generated from mfsecrets when getting the username for audit. This has

been fixed.

(382026)
• For Enterprise Server LDAP-based security, two new options, [Operation] group membership uses

short name and [Operation] search users by short name, permit applying user and group data to
users known to that Security Manager only by their short name (the Enterprise Server user ID). See
MLDAP ESM Module Custom Configuration Information in your product Help for more information.

02344601 (301036)
• In ESCWA on the Catalog page, you can now use the Line Wrap switch to toggle line wrapping for long

lines.

02289615 (258187)
• The ESCWA SEPs page displays Transient and Debug SEPs.

(327011)
• In ESCWA, accessing the Catalog file data has been improved by modifying the page layout.

02154749 (202107)
• In ESCWA, focus would not be put into modal dialogs when opened. This has been fixed.

01995433 (156067)
• ESCWA now displays more clearly when operating in Windows high contrast mode.

01995438 (161036)
• In ESCWA, the maximum height of list menus have been limited so that they do not overflow the screen

from their position, with a scroll bar to access all items.

02499988 (403117)
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• In ESCWA, the SEP List page did not correctly sort the list by ascending or descending order. This has
been fixed.

02382568 (352007)
• ESCWA was not able to bind to a hostname containing the w character. This has been fixed.

(296023)
• The ESM password is no longer disclosed in the /esf endpoint request.

02554256 (450046)
• Reduced the number of password save prompts encountered when navigating ESCWA using the

Firefox Web browser. 

02324422 (306001)
• In ESCWA, the FCT Backward and Forward Recovery will no longer be disabled when Use Catalog is

selected.

02416596 (364107)
• When ESCWA was configured for TLS, it failed to stop when using escwa --shutdown from the

command line. This has been fixed.

02405704 02004795 (365071)
• Added missing annotation for ESCWA trace point.

02538486 (415187)
• ESCWA had duplicate CTF trace IDs. This have been fixed.

02524827 (409072)
• In ESCWA, the additional column File Size has been added to the catalog list view.

(403123)
• ESCWA might fail to disconnect from a Redis instance and reconnect to another. If this occurs you can

manually trigger a reconnect action by clicking the Reconnect button on the Scale-Out Repository
Information page.

(363105)
• If ESCWA auditing is enabled from the Configuration page, or when ESCWA ESF auditing is enabled

from the Security > ESCWA Configuration page, then an auditing event is emitted, 2 19 (auditing
stopped), or 2 20 (auditing started). See Audit Event Codes in your product Help for more
information.

02412285 (365156)
• In ESCWA, you can now rename catalog data sets from the Catalog page. See Adding and Editing the

Catalog Entry in your product Help for more information.

02501074 (403136)
• In ESCWA, the “Historical Statistics Detail for Transaction” and “Historical Statistics” pages now

display time in milliseconds and the accuracy for latency and response information has been improved.

02504559 (405096)
• A new CGI threshold type has been implemented in Enterprise Server. This enables you to set up

threshold values for ESCWA and ESMAC requests by applying the global =CGI to all ESCWA and
ESMAC requests, or by specifying the corresponding casrdo or casrdj module that you want to
control.

(377073)
• MFDS no longer supports XA reconnect attempts.

(427068)
• In ESCWA, the PCT Security flag is now displayed on the Active PCT page. See Active PCT in your

product Help for more information.

(335002)
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• Resolved an issue with a mutex deadlock created when MFDBFH attempted to emit a message during
a cascd shutdown. 

02468209 (406002)
• A problem that caused Web Service client calls to fail after an upgrade has been fixed.

02320601 (307054)
• An intermittent Access Violation in mfredis.dll sometimes occurred when a batch job abended. This

has been fixed.

02328218 (296144)
• ECI transactions were not being committed at the end of task. This has been fixed.

02497005 (403085)
• An issue that resulted from pressing the Clear key following a EXEC CICS SEND PAGE command has

been fixed.

02423737 (375058)
• The recovery of processes by casmgr now occurs in the same order in which they were terminated.

02449487 (389051)
• A bitism issue with the triggers provided with the product has been fixed.

02554978 (449002)
• An issue with updating a transaction ID in ESMAC has been fixed.

(264059)
• A WEB RECEIVE SESSTOKEN sometimes threw an RTS 114 error in cascwi. This has been fixed.

(409046)
• Dynamically enabling HSF sometimes resulted in shared memory corruption. This has been fixed.

(411104)
• In a PAC, closing an FCT that referenced a catalogued file sometimes resulted in a truncated filename

after 44 characters. This has been fixed.

02421476 (364152)
• The casfile, casout, casstop, cassub, castran, and casutl commands now find the enterprise

server region successfully when mfds is started with the -b option.

02307940 02202467 (286003)
• An error message was unnecessarily exposing input credentials. This has been fixed.

02409369 (363126)
• When using casout, the /y option could fail depending on the order of options used. This has been

fixed.

02371843 (313041)
• An internal transaction (ITR) was not sent to a SEP that had an EZASOKET listener started. This

sometimes resulted in a close file request failing to be processed by the SEP running the EZASOKET
listener. This has been fixed.

02394276 (350047)
• When an XA issue occurred, the reason code was not always returned. This has been fixed.

02532560 (425053)
• An intermittent crash in casmgr has been fixed.

02431740 (377040)
• When performing a NEWCOPY on a data table in a PAC, not all enterprise server regions in the PAC

reloaded the new member. This has been fixed.

02406797 (364015)

26 | Resolved Issues



• Thresholds are now started before the XA start for a transaction has been issued, enabling the process
to be killed if the transaction is stuck in the Resource Manager.

02365811 (306124)
• When using the CICS command castran with the -b option, the message was not sent to the

console.log file. This has been fixed.

02389970 (348041)
• When multiple requests were made from the same browser, a new TCTS was allocated, resulting in an

SOS situation. This has been fixed.

02419170 02404921 (364124)
• When using TRANCLASS and refreshing ESMAC, the data sent to a started transaction could be lost,

resulting in ENDDATA returned on the retrieve. This has been fixed.

02526457 (451029)
• The sample exit program DFHUSYNC has been modified to not return cics-syncpoint-normal-88 by

default as this could overwrite the correct return-code set on a previous call to an RM.

02492604 (409026)
• The RAS process is now correctly identified on a dump.

(385051)
• Fixed a memory corruption that occurred when logging in-doubt XA transactions in the PAC.

02304565 02319810 (284038)
• Replaced ESF Admin API LISTRESOURCE with ESF Auth for querying MQ Security Resources.

02154003 (202145)
• Updated XID generation to support UTF-8 code pages with PostgreSQL.

02296723 (273006)
• A shared memory corruption issue occurred when reinstalling a TCPIP Service or URIMAP. This has

been fixed.

(204047)
• Improved error reporting when applying advanced configuration updates in a PAC environment.

(364113)
• The casesxml utility now provides a relevant error message when no work location is provided.

02531150 (413115)
• The casstop command output misleading error messages when immediate shutdown was used. This

has been fixed.

02490512 (403132)
• The dynamic region configuration updates occasionally failed to apply. This has been fixed.

(245030)
• If an enterprise server region contained $ES_SERVER in its configuration, then it would not be handled

by casesxml. This has been fixed.

02531150 (417037)
• To improve efficiency, when an enterprise server region is configured with multiple RMs and a task uses

only one, no XA log is created for the transaction.

02537701 (430016)
• When calling APPC functions, you could pass an invalid value in the first parameter which would result

in an error in the communications server layer. This has been fixed.

02428147 (372009)
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• When using LU6.2 communications infrastructure between enterprise server regions, when a COMMIT
was executed by the originator, the target would incorrectly attempt to send a commit request back to
the region which sent the sync point request. This has been fixed.

02339327 (296039)
• When using LU6.2 communications infrastructure between enterprise server regions, the processing of

SYNCONRETURN on a Distributed Program Link was preventing switching between remote systems
(SYSIDs). This has been fixed.

02336501 (296104)
• When using LU6.2 communications infrastructure between enterprise server regions, an ABEND in the

target region would result in the SEP which was processing the request hanging. This has been fixed.

02287147 (259103)
• A DPL request from Tuxedo over LU6.2 could result in an RTS 114 error being reported. This has been

fixed.

02531060 (421001)
• HSF records for Java ECI transactions now display the transaction name instead of CASECIP.

02338437 02353043 02394280 (296126)
• The latency value in HSF records could be incorrect for transactions started via DPL. This has been

fixed.

02504559 (407143)
• Some Redis connections from castmc, castrc, and cassi processes were not being disconnected

and remained open. This has been fixed.

02198949 (222162)
• The casstart utility now accepts variable wait times for the /w parameter. See casstart in your

product Help for more information.

(365010)
• HSF now reports that 100% of transactions meet performance criteria when no transactions are

measured for that period.

(385065)
• Dynamic Debugging failed on secure enterprise server regions with certain security configurations. This

has been fixed.

02408468 (363059)
• Enterprise Server Clustering is now deprecated. Micro Focus recommends that you adopt the Scale-

Out Performance and Availability Cluster (PAC) solution for your clustering requirements. See Scale-Out
Performance and Availability Clusters in your product Help for more information. In addition, the
LOCKDB feature has been added to replace the functionality of the Enterprise Server Cluster Global
Lock Manager (GLM). See Enterprise Server LOCKDB for more information.

(363157)
• An enterprise server region sometimes crashed after MFCS and the ADMIN SEPs were killed. This has

been fixed.

02415369 (364089)
• A new CGI threshold type has been implemented in Enterprise Server. This enables you to set up

threshold values for ESCWA and ESMAC requests by applying the global =CGI to all ESCWA and
ESMAC requests, or by specifying the corresponding casrdo or casrdj module that you want to
control.

02426463 (370004)
• You can use the new ES_HARD_KILL_PROCESS environment variable to modify how Enterprise

Server kills a process. See General Enterprise Server Environment Variables in your product Help for
more information.
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02365440 (355015)
• Added a new Retrieve action to the caspac utility to enable you to retrieve binaries loaded on an SOR.

See caspac in your product Help for more information.

(284104)
• A new /z parameter has been added to the following commands-line utilities: casfile, casout,

casstart, casstop, cassub, castran, and casutl. The parameter enables you to pass user
credentials through an interactive prompt or a redirection from the console. See the respective
command-line topics in your product Help for more information.

(303013)
• In Enterprise Server with LDAP-based security, the effect of the value 0 for the attribute microfocus-

MFDS-User-MTO-Timeout was documented incorrectly. When this value is 0, the enterprise server
region's default user timeout is used. See Defining a User with LDIF in your product Help for more
information.

02305957 (276010)
• The following environment variables can now be configured as properties on the ESCWA Advanced

Region Properties page: ES_SEP_DORMANT_TIME, CAS_SRV_CANCEL, and
 ES_MAX_CATALOG_LINES.

(348002)
• The following environment variables can now be configured as properties on the ESCWA Advanced

Region Properties page: ES_DDBG_PORT_RANGE, ES_ESMAC_DISP_MAX_OVERRIDE, and
ES_SOR_RETRIES.

(306023)
• The supported list of cipher suites has been updated to TLS v1.3.

02320601 (401139)
• An issue that prevented the user ID from being found and that then failed to report this back to the

application has been fixed.

02459379 (395007)
• When running with futex support, enterprise server regions would no longer start due to a logic error.

This has been fixed.

(308024)
• In TRANCLASS enterprise server regions, non-TRANCLASS Temporary Storage Queue (TSQ)

processing can now be enabled by setting ES_TRANCLASS_EXCEPT_TS=Y.

(387013)
• Support for TS queues of type Exclusive has been improved by correcting error conditions and now

retaining queue recoverability after a DELETEQ.

(386014)
• A bug in the castsc process meant that it could trap in casstore when a terminal disconnects. This has

been fixed.

(368001)
• In a PAC, access to an FCT could immediately reopen an FCT that had just been closed by another

enterprise server region. This has been fixed.

02421476 (375005)
• A WRITEQ TS using the REWRITE option against a non-existent queue was incorrectly returning

ITEMERR instead of QIDERR when running with ES_TRANCLASS_EXCEPT_TS=Y. This has been
fixed.

02515519 (405171)
• An issue with the start initiator button not being correctly disabled when a user was not authorized for

the casout resource (OPERCMDS) has been fixed.
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02503261 (401173)
• A loop that occurred when trying to recover PIDs after MFDBFH lost the connection to the database has

been fixed.

02373280 02362273 (322009)
• MQ security was being disabled when Allow unknown resources was enabled. This has been fixed.

02328521 (288019)
• When a process dies in a PAC, casmgr in the recovery process tries to call MFDBFH to recover the

process, close all files opened by that process, and release all the locks. If the connection to the
database was lost, the call to MFDBFH would fail and the process only recovered if the connection was
restored at region termination. Updates in this release now keep track of the process that could not be
recovered and retries when the connection is restored. On region shutdown, all orphan ITRs that
belonged to the current region are now removed. At start up, all orphan ITRs that were targeted to the
region are removed.

02345487 (303043)
• An incorrect HSF latency calculation when the transaction was using a TCPIPSERVICE has been fixed.

02439855 (387136)
• When using DEFINE LIBRARY, casrdtup was hanging. This has been fixed.

02422104 (372043)
• You can now specify thresholds for ESCWA and ESMAC requests using the new type CGI and by

specifying the casrdxxx module name or a global threshold =CGI. This ends the request abnormally if
the threshold is exceeded, and stops the admin SEPs from being blocked on long requests accessing
ESCWA or ESMAC.

(372055)
• Invalid messages have been removed from the Catalog Display when details are enabled.

02501609 (405074)
• A local memory leak that occurred when logging XA transactions in a PAC has been fixed.

02319834 (285102)
• An issue with MQ security checks when security resource prefixes are used has been fixed.

02483959 (397010)
• Ambiguous MQ security rules failed to enable security checks. This has been fixed.

02375426 (314055)
• The subsystem security switch was not being set to OFF when the MQADMIN class was not defined.

This has been fixed.

02483959 (399003)
• All authentication checks for Dynamic Debugging operations are now skipped if the casdebug entry is

not available under the OPERCMDS security resource.

02367824 (314007)
• An issue with MQ security console messages not containing the actual resource being checked has

been fixed.

02483959 (399002)
• Return code handling for create process requests on Windows platforms has been improved.

02290153 (307032)
• When using LU6.2 communications infrastructure between enterprise server regions, an ABEND raised

by the target application would result in subsequent attempts to establish a conversation to fail. This has
been fixed.

02339327 (297043)
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• HSF reported latency for incoming remote DPL requests were not being reported correctly. This has
been fixed.

02455011 (392023)
• Windows Performance Counters now work using a V2 provider DLL and will appear in Performance

Monitor under 'Micro Focus Server System V2'.

(286029)
• Security checks are now supported for Dynamic Debugging operations. Checks are carried out against

the casdebug entry under the OPERCMDS resource class.

02337725 (296095)
• When using casesxml, if the enterprise server definition has been exported using the -c option then

you must import using the -c parameter.

(351045)
• An issue with the TType page (Signoff attribute) affecting ESCWA and ESMAC has been fixed.

(402014)
• In ESCWA, the field did not display the correct time. This has been fixed.

02470813 (393069)
• The JSON ESMAC spool details module now reports the UUID of the PAC member which processed a

batch job back to ESCWA.

(293036)
• The ESCWA API call /native/v1/regions/host/port/region/users/resource has been

fixed.

02382647 (340024)
• In some circumstances MFDS incorrectly granted permissions. This has been fixed.

(365086)
• An Enterprise Server Security Manager using the MLDAP ESM Module with caching enabled no longer

incorrectly caches partial results when an LDAP search cannot return the full result set due to the
server's size limit on responses. The module will always switch to an LDAP paged search when
necessary, bypassing the cache. This corrects an issue where customers with a large number of
resource rules might sometimes get incorrect security results (typically access denied when it should
not be) after the first time that resource class was queried.

Note: If you cannot apply this fix, you can work around it by disabling caching for the Security
Manager. ESF caching, which is set in the Security properties for the enterprise server region, can
remain enabled.

02475614 (397047)
• Enterprise Server security did not always assign supplemental groups to users in certain configurations

with multiple Security Managers, Federation enabled, and All Groups enabled. This has been fixed.

02145921 (202146)
• The ability to change passwords through the OS ESM Module was broken in version 1.10.4 of that

module. That has been fixed.

02408023 02417238 (363081)
• Issues with changing passwords through the OS ESM Module have been fixed.

02408023 02425417 (370007)
• For Enterprise Server LDAP-based security, a new configuration option, [Operation] check

constraints for already-verified users, lets an MLDAP Security Manager deny sign-on for a user even
if an earlier Security Manager has chosen to allow the Verify request. See MLDAP ESM Module Custom
Configuration Information in your product Help for more information.

02346703 (297133)
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• The esfupdate utility now supports the Micro Focus Vault Facility for retrieving secrets. See To Update
Security Manager Changes Using esfupdate in your product Help for more information.

02510669 (406066)
• When both BATCHONLY and LOCALTX are set to true, one-phase-commit batch jobs no longer trigger

two-phase commit connection in the recovery transaction.

02407338 (364098)
• The XA ODBC switch module now gets the correct server status, enabling the Enterprise Server

RECONNECT feature to work correctly.

02408845 (362020)
• XA switch modules that use OpenESQL now work correctly when the applications in Batch transactions

are compiled with XAID directive option.

02327393 (293012)
• The DB2 switch module now sets the PackagePath after switching to the user.

02269497 (258224)
• XA switch modules no longer return an MFDBFH registration error to Enterprise Server, ensuring that

non-MFDBFH transactions continue using the XA connection.

02452753 (385055)
• The correct OCI_ATTR_SERVER_STATUS is now used to query Oracle Server status.

02391332 (335016)
• XA recovery is now performed correctly for DB2 in-doubt transactions when the enterprise server region

is next started.

02474721 (402001)
• You can now build the SQL Server RM switch module on UNIX platforms. See SQL Server RM Switch

Module in your product Help for more information.

(365126)
• The Region Trace Control process (castrc) was incorrectly creating multiple connections to Redis

after a RD-NOAUTH return code. This has been fixed.

02319798 (335004)
• Intermittent CONNECT_ERROR issues occurred when accessing data from MF Directory Server via

ESCWA. This has been fixed.

02532852 (425068)
• A socket handle leak occurred if the connection to the MF Directory Server process failed. This has

been fixed.

02435329 (382013)

File Handling

Back to the list

• The performance the Data File Editor has been improved when navigating within variable-sequential or
line-sequential files accessed through a Fileshare server.

(401106)
• File Status no longer returns corrupt index file for a non-corrupt file, under high traffic.

02513640 (406155)
• A COBRT114 error no longer occurs when using read-direct on VB file header records.

02490607 (400074)
• Background changes have been made to the external file handler when dealing with sequential files.

(382072)
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• Performance improvements have been made when navigating to the last page of a variable-length file in
the Data File Editor.

02476713 (394163)
• Fileshare could crash when processing some unexpected sequences of operations for a connected

Data File Editor. This has now been fixed.

02409270 (365144)
• In some scenarios, zombie processes could result in an incorrect reporting of open files in the system.

This has now been corrected to better detect when such scenarios occur.

(297118)
• It was possible for an ODBC/OCI exception (such as a connection timeout) to occur in the optimized I/O

thread when accessing files via MFDBFH. This could cause the process to hang, and so defensive
measures have been taken to resolve this.

02481017 (405157)
• An issue where MFDBFH would incorrectly return a 9/139 error when attempting to open a file that did

not have a key definition area specified in the FCD has now been fixed. The behavior is now the same
as it is on disk.

02394334 (350036)
• Oracle statements were previously using deprecated OciStmtPrepare calls, which meant that the

Oracle application failover/transaction replay could not be used. This has been updated to now use
OciStmtPrepare2.

02441885 (384027)
• A timing issue when closing the connection to the database caused an SEP to crash on region

shutdown. This has been resolved.

(254034)
• The time required to return after reading a large number of records from large files hosted in MFDBFH

was excessive due to the large number of SQL queries being executed. These queries have now been
optimized to improve performance.

02396919 (384007)
• Enterprise Server sometimes failed to recover processes that died after losing and then reestablishing a

connection to the database. To mitigate this, Enterprise Server has been updated to attempt recovery of
these processes at a later time in the event that the database connection cannot be reestablished.

(326009)
• SYSOUT SSTM data sets were being incorrectly marked as using an In-Memory record-locking strategy

when hosted within MFDBFH, which returned a 9/100 status due to multiple processes attempting to
write display statements to the data set. In this scenario, SYSOUT SSTM data sets now use the default
Table record-locking strategy.

(299014)
• MFDBFH has been updated to be sensitive to the FAN settings on an Oracle Database, and is now

immediately notified when the database attempts to drain connections. In this case, MFDBFH attempts
to establish a new connection.

(375030)
• When registering an XA connection with MFDBFH, the registration process attempted to connect to

each entry in the MFDBFH.cfg file to determine if it matched the details of the XA resource. Underlying
improvements have been made to reduce the number of connections made when the MFDBFH.cfg file
contains duplicate entries.

02459182 (390041)
• If the connection to an Oracle RAC environment was lost at a specific time, a COBRT114 error was

sometimes thrown in the XA Switch module. Additional checks have been added to the code to ensure
that this is no longer the case.
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02366126 (350015)
• When using an Oracle database, if the connection was lost, the process failed to reconnect once the

connection to the database was reestablished. This has now been resolved.

02410660 (363051)
• Oracle queries that issued searches against large files used a full-table scan, slowing performance.

Performance has been improved by instructing the Oracle optimizer do a range scan instead of a full-
table scan in this case.

02516560 (406164)
• Additional diagnostics information has been added to assist in determining the cause of an RC 3 on

MFDBFH recovery processing.

02344102 (299021)
• A WRITE operation that used ADVANCING mnemonic-name sometimes threw an error. Support has

now been added to handle WRITE operations with mnemonic usage.

02209654 (246009)
• When a database ran out of available connections, stored procedures and functions were sometimes

lost. This release contains updates that reduce this risk.

02155281 (203093)
• A progress bar has been added to dbfhdeploy operations.

(381028)
• A new environment variable, MFDBFH_GRANT_USER_PERMISSIONS, has been added for Oracle

databases only to allow MFDBFH to grant execute privileges on types/procedures to specific users/
roles. This provides easier user privilege restriction on Oracle and creates a more secure environment
without having to manually modify the MFDBFH scripts. 

02459320 (389032), 02441860 (384006)
• Additional checks have been added to verify the integrity of the region/cross-region database tables

before running dbfhadmin -casprocess -recovery. If required, you are prompted to run
dbfhadmin -verify to fix the table integrity before recovery can continue.

02326339 (297036)

Micro Focus Common Client

Back to the list

• The Micro Focus Common Client now adds Accept and Origin headers with default values to HTTP
requests if the invoking program has not set its own values for those headers. This improves
interoperability with some Web services.

Note: This affects COBOL Web service client proxy programs.

(104096)

Micro Focus Cryptographic Library

Back to the list

• The version of OpenSSL provided with the product has been updated to 1.1.1t.

(407184)

Micro Focus Directory Server

Back to the list

• MFDS stopped when supplied with the incorrect mfServer property when updating an enterprise server
region. This has been fixed.
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02547102 (442003)
• The casstart /s option incorrectly copied the start-type parameter. This has been fixed

02250159 (244185)
• An issue that sometimes caused MFDS to crash when starting multiple enterprise server regions

simultaneously has been fixed.

02310876 02409262 (286081)
• Micro Focus Directory Server internal session identifiers have been increased in size and complexity to

reduce vulnerability to attack.

02365249 (344004)
• Starting or stopping an enterprise server region using ESCWA or the MFDS UI intermittently terminated

the process. This has been fixed.

(415049)
• Modifying or deleting an enterprise server region's MFRHBINP Request Handler via the ESCWA user

interface or API is no longer allowed.

02525461 (413117)
• Enterprise server region start-up performance was slow when a large number of regions were specified

on a Micro Focus Directory Server with a large number of values stored in the vault facility. This has
been corrected.

(394122)
• If the MFDS process could not access the TCP port it was configured to use, it failed to start and

emitted the error message HS0001S HTTP server failed to initialize, rc=6:
CCITCP-0006E An invalid server or machine name was presented to CCITCP. It now
fails with the message HS0001S HTTP server failed to initialize, rc=57:
CCITCP-0057E Insufficient permission to complete an operation.

(388038)
• If the MFDS process could not access the TCP port it was configured to use, it failed to start and

emitted the error message HS0001S HTTP server failed to initialize, rc=6:
CCITCP-0006E An invalid server or machine name was presented to CCITCP. It now
fails with the message HS0001S HTTP server failed to initialize, rc=57:
CCITCP-0057E Insufficient permission to complete an operation

02433110 (380037)
• Some audit events output when setting the Create Audit Events option for the MFDS process using the

MFDS Web interface were not being output when using ESCWA to change the same configuration. This
has been corrected.

02412285 (365078)
• MF Directory Server Enterprise Server Administration HTML Web interface was accepting UNC paths

as input values for some import and export operations. This has been fixed.

02423785 (369017)

Micro Focus License Administration

Back to the list

• Micro Focus License Administration now displays the licenses for the same product and serial number
but with a different expiry date on separate lines.

(365148)
• Some libraries have been updated to fix current known vulnerabilities.

(295042) (295068) (309006)
• The SafeNet server list can now be used as expected.
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02341760 (259135)

Run-time System

Back to the list

• The memory associated with a dynamic length item declared in local-storage was not released when
the program instance exited, which led to memory leakage. This has been fixed.

(443004)
• The Run-time System now produces an RTS error if the Profiler attempts to output an .ipf file in a

read-only directory.

(407092)
• An issue in the native Run-Time System's clean-up logic sometimes resulted in a crash when a .NET

AppDomain running a .NET COBOL program was unloaded. This has now been fixed.

02259505 (301047)
• Previously, in some ES region configurations, enabling CTF tracing for RTS API events could result in

very large CTF trace log files, and cause an ES region to take a very long time to start. This has now
been fixed.

02320601 02497148 (403104)
• The event priority of a CTF API entry is set to a default value of 0 when CBL_EXIT_PROC is called with

a function code that does not expect a priority or provides an invalid one.

(380019)
• Printer settings, such as the paper size, etc., selected in the Printer dialog box loaded from

PC_PRINTER_SET_DEFAULT when browsing for a default printer, were not in effect during printing
from native and .NET COBOL programs. This is now fixed.

02260752 (285002)
• Using a DISPLAY statement from a SQL CLR stored procedure sometimes resulted in a

System.NullReferenceException. This is now fixed.

02533532 (415173)
• The validation of the logical printer position in PC_PRINTER_SET_POSITION assumed that paper size/

printable area size properties always matched printer orientation, and therefore sometimes erroneously
reported error 31 (BadPosition) when printing from .NET COBOL programs. This is now fixed.

02478164 (394154)
• Selecting a custom paper size in the Printer dialog box loaded from PC_PRINTER_SET_DEFAULT

when browsing for a default printer sometimes resulted in Run-time System error 9/004 when printing
from .NET COBOL programs running in remote Azure VMs. This is now fixed.

02416340 (365222)
• Selecting a custom paper size in the Printer dialog box loaded from PC_PRINTER_SET_DEFAULT

when browsing for a default printer sometimes resulted in a Run-Time System error 9/004 when printing
from .NET COBOL programs. This is now fixed.

02416340 (365116)
• Publishing a program with an XML GENERATE statement in an SQL stored procedure now works as

expected once the project files are manually edited appropriately.

02508845 (407057)
• When using CBL_THREAD_CREATE_P to create a thread in a .NET COBOL application, the stack-size

parameter was ignored so the created thread always used the default stack size. This has now been
fixed. 

02344128 (296105)
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• When printing using printer redirection in .NET COBOL programs, written records are buffered by
default for performance reasons. Previously, this could have resulted in misaligned text if a record
starting with many leading spaces ends up split between different buffers. This has now been fixed.

02260785 (284116)
• Native preprocessors (including COBSQL, HTMLPP, and PREXML) are not currently supported in .NET

6 applications.

(425003)

SQL: COBSQL

Back to the list

• A problem with COBSQL that prevented it from handling the FETCH conversion of more than 100K
rows has been fixed.

02236464 (260248)
• COBSQL has ben updated to handle ENTRY statements broken into multiple lines.

02417156 (367003)
• COBSQL has been modified to handle inline comments in EXEC SQL statements when using the

SYBASE precompiler.

(285007)
• COBSQL has been updated for SYBASE such that it no longer inserts a period when an EXEC SQL

statement is coded inside of an IF block. 

01886033 (125015)
• COBSQL has ben updated to handle inline comments inside DECLARE blocks when Informix is used.

02380790 (348020)
•  The COBSQL preprocessor has been updated to support the ALPHA-LIT-CONT directive.

02544092 (430025)

SQL: DB2 ECM

Back to the list

• The DB2 ECM now correctly sets the length of the PIC G host variables before CHARSET conversion.

(424053)

SQL: OpenESQL

Back to the list

• A problem that caused erroneous memory usage in the OpenESQL run time has been fixed.

02321779 (293023)
• A problem that prevented parameters in the ADO UNBIND CONNECTION statement from being

replaced has been fixed.

(406004)
• A problem that prevented a temporary table from being created has been fixed.

02494026 (401152)
• A problem that prevented PostgreSQL from applying the expected values when set statements

contained three or more host variables has been fixed.

02506484 (405077)
• The .NET 6 ODBC Nuget package was missing some dependencies. These are now included.

02474422 (395110)
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• The column length of a VARCHAR type column was returned incorrectly when the SQL statement was
being prepared dynamically. This has been corrected.

02503856 (405091)
• A problem that prevented database locks from being released at the end of an DSNALI transaction

when using switch modules that use OpenESQL has been fixed.

02307521 (296031)
• A problem that occurred when specifying the SQL(CLOSE_ON_ROLLBACK=NO) directive caused SQL

Server to automatically close a cursor after a rollback statement has been corrected.  The cursor is now
defined as a fast-forward cursor instead of a fire-hose cursor.

(401104)
• A problem with the ODBC ECM that produced a subscript-out-of-range error when using a host variable

with a leading FILLER item before a data item in an SQL statement has been fixed.

02334866 (312064)
• A problem with using msbuild from a Visual Studio prompt caused build warnings referring to the SQL

native runtime DLL. This has been resolved. The required dependency file was added to the ODBC
SQL Runtime Nuget .NET 6 packages.

02474156 (393120)
• A problem that sometimes occurred when compiling DBCS code in SJIS locale for embedded SQL

applications has been fixed.

02349559 (301080)
• An exception error that occurred when trying to run .NET Core/.NET 6 COBOL SQL applications with

the SQL ODBC runtime Nuget packages with a Windows command prompt has been resolved.

02351590 (306091)

Visual Studio IDE

Back to the list

• Server Explorer now displays the enterprise server regions if ESCWA was not started as a Windows
service.

02458571 (415100)
• An issue with the Dialog System Painter menu item using an incorrect path location in Visual Studio

2022 has been resolved.

02466323 (395008)
• Using the Micro Focus transport on the Attach to process dialog box now works correctly in Visual

Studio 2022.

(264035)
• When the .idy file for a project cannot be found when debugging, Visual Studio no longer accesses

the disk continually in an attempt to find it.

(258033)
• Visual Studio now passes credentials when enabling a server for dynamic debugging.

(295085)
• Projects using Pro*COBOL can now be built from the command line using MSBuild.

(382060)
• An issue where pressing F5 to launch a Unit Test Project would fail to run any test cases has been

resolved.

(264092)
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• Projects that use a mainframe COBOL dialect could fail to set the RTNCODE-SIZE Compiler directive
correctly due to the use of explicit setting or unsetting of the P64 Compiler directive depending on the
project configuration. This has been fixed.

02523704 (410091)
• An issue with the installation of the Visual Studio extensions has been resolved.

02516155 (399062)
• Large data reference counts are now shown correctly in the IDEs.

02130631 (195070)
• The keyword string is no longer highlighted as a verb when it represents a System.String.

(254035)
• Code cleanup can now change the case of keywords in your code. You can specify the preferred case in

the code cleanup preferences, then use the Format Document with Code Cleanup or Format
Selection with Code Cleanup  commands on your code to apply the transformation.

02503932 (403171)
• Previously, the editor would display a data item as grey and not red if it has been previously referenced

32766 times. This limit has been increased to 65533.

02426569 (371012)

XML Support

Back to the list

• The XML runtime now performs better when reading a large XML file.

02526445 (417029)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Defect number (in parentheses).

• (295041)
• 02508043 (407049)
• 02479358 (393153)
• 02504425 (424001)
• 01901711 (127012)
• 02287394 (258209)
• 02558536 (447020)
• 02190101 (363024)
• (381007)
• (384016)
• 02450685 (386098)
• 02423113 (364179)
• 02439474 (382038)
• 02453576 (385060)
• 00373758 (448044)
• 02500115 (406011)
• (402012)
• 02458038 (387132)
• 02544746 (425075)
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Unsupported or Deprecated Functionality
This section includes information about features or functionality that are not supported.

• The SafeNet Sentinel licensing system has been deprecated and will be not available in this product
starting with the next major release - release 10.0. The SafeNet Sentinel licenses will not be supported
after release 9.0. You can only use AutoPass licenses starting with release 10.0.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
However, it is not necessary to switch to AutoPass licenses unless you are adopting release 10.0.
Contact Micro Focus Customer Care for further information.

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
This is a change since version 3.0 of this product.
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Additional Software Requirements
To ensure full functionality for some Visual COBOL features, you might be required to obtain and install
additional third-party software.

See this information on the Product Documentation pages on Micro Focus Customer Care, in the product
help for Visual COBOL for Visual Studio 2022 (click here).
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Installation

Before Installing

Downloading the Product
1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/

download/downloadCenter.
2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any patch
updates.

6. Click Download on the relevant row.

On Windows

System Requirements

Hardware Requirements

Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.

The maximum disk space requirements are, approximately:

Visual COBOL Sentinel RMS License Manager

1.2Gb 75MB

• This includes the space needed to cache information locally so that you can modify the installation
without the original source media.

• The disk space requirements include the versions of JRE and .NET Framework supplied with the setup
file.

Operating Systems Supported

For a list of supported operating systems, see Supported Operating Systems and Third-party Software in
your product documentation.

Note:

• A 64-bit Windows is required. You can produce both 32-bit and 64-bit applications with Visual
COBOL installed on a 64-bit operating system.
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Software Requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components. A supported version of Microsoft's Visual Studio must
be installed in advance.

Besides the software listed below, the setup file also installs the 64-bit AdoptOpenJDK 17.0.4 (LTS) with
Hotspot.

This product includes OpenSSL version 3.0.

• Visual Studio IDE
• Selecting the Visual Studio components to install
• Installing Visual Studio features that are not currently installed
• License Manager requirements
• Other Requirements

Visual Studio IDE

You must have Microsoft's Visual Studio 2022 version 17.4 or a newer one installed in advance.

You need one of the advanced versions of Visual Studio listed below:

Professional, Enterprise or Community Edition - see the next section for the Visual Studio components
you must install.

Microsoft's Visual Studio Express Edition is not supported.

Important:

• When installing Visual Studio, ensure you select the Help Viewer component for installing if you
want to view the Visual COBOL product help inside Visual Studio. When you select components to
install in the Visual Studio installer, click Individual components and check Help Viewer in the
Code tools section.

The following software is also required:

• Microsoft .NET Framework 4.7.2. This is included with Visual Studio.

Selecting the Visual Studio components to install

The Visual Studio installer enables you to customize and only install the workloads and components that
are most suitable for your area of development. For example, you can select the components that are
required for .NET desktop development, ASP.NET Web or C++ development.

If not already installed, the Visual COBOL setup file will install the following components:

• .NET Framework version 4.7.2.
• Debugger
• Data services

A number of workloads and components are optional and only required by specific types of applications or
tasks:

• Azure, WCF, Web, WPF, MSVC, or SQL CLR application development.

Important: The latest version of the C++ x64/x86 build tools component, which is part of the MSVC
Workload, is required to generate some IMTK clients.

If you require any of these, you can select them when you start the Visual Studio installer or, enable them
after completing the installation - see the next section.
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Installing Visual Studio features that are not currently installed

If a feature of Visual Studio was not installed during the Visual Studio installation, the respective
functionality or the project templates for it are not available. You can install a missing feature in one of the
following ways:

Rerun the Visual Studio installer:

1. Start the Visual Studio installer and choose to modify an existing Visual Studio instance.
2. Select the workloads and the components that are missing (for example, ASP.NET and web

development or Help Viewer).
3. Start the Visual Studio installation.

Use the Quick Launch control in Visual Studio:

1. Start Visual Studio.
2. Type the name of the feature in the Quick Launch control - for example, type ASP.NET or Help

Viewer.

A drop-down list with any features matching your search string appears. If the feature is not already
installed, one of the search results will be an option to install it.

Use the Install Missing Feature(s) command in Visual Studio:

1. Start Visual Studio.
2. Click Help > Micro Focus Product Help > Install Missing Feature(s) > Feature Name.

Follow the instructions in the installer to install the missing feature.
3. Alternatively, if a Micro Focus project template requires a Visual Studio feature which is not currently

installed, the IDE displays an information bar with instructions to install the feature.

License Manager requirements

• The Micro Focus License Administration tool requires Java to run. It supports Java 1.7 or later.
• For local servers, you do not need to install the Micro Focus License Administration tool separately, as

the setup file installs a new Visual COBOL client and a new licensing server on the same machine.
• If you have any network license servers, you must update them before you update the client machines.
• If you are upgrading from Visual COBOL release 2.2 or earlier, uninstall the license manager before

installing the product.

You can download the new version of the license server software by following these steps:

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter.

2. Select your account and click Downloads.
3. Select a product and a product version from your orders.
4. In the list of software downloads, locate the License Manager.
5. Click Download to download an archive with the installers.
6. Run the installer suitable for your Operating System to install License Manager on your machine.

Other Requirements

Various actions and operations within your COBOL development environment depend on certain files that
Microsoft distributes in the following package: the Windows SDK package. See Microsoft Package
Dependencies for a full list of actions and operations that require one or both of these packages.

By default, the product installation installs the latest versions of the Microsoft Windows 10 SDK, and the
Microsoft Build Tools for Visual Studio 2017, to their default locations.
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If you need to use any other version of these packages, or use them installed to a non-default location, use
the cblms command line utility post-installation to manage this; see Managing the Microsoft Build Tools
and Windows SDK Packages for more information.

Product Co-Existence
• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine regardless of which IDE

(Visual Studio or Eclipse) you install.

Installation Restrictions and Requirements
Before starting the installation you should consider the following:

• If, when you install Visual COBOL, the machine does not have Microsoft Visual C++ 2017
Redistributable Runtime already installed, it is installed as required by Visual COBOL. The installation of
Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital signatures,
into the winsxs directory.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Various actions and operations within your COBOL development environment depend on certain
Microsoft files distributed in the following packages: the Windows SDK package and the Microsoft Build
Tools package. By default, a standard product installation downloads and installs these. Refer to
Microsoft Package Dependencies to see if these packages are required. If you do not plan to use your
development tool in a way that will depend on any of these packages, you can run a non-standard
installation, which will skip their download and installation, thus saving disk space and time taken for
installation. Refer to Advanced Installation Tasks for details on the available installation options.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations, see Advanced Installation Tasks in your product Help.

Installing
Note:

• This version of the product is a full install.
• See Before Installing first for important information. Also, see Installing as an Upgrade, if you have

an earlier version of Visual COBOL installed on your machine.

To install this product:

1. Run the vcvs2022_90.exe file and follow the wizard instructions to install the prerequisite software
and the product.

2. If, after installing, there are issues with using the Micro Focus functionality, you might need to execute
the following command from a Visual Studio command prompt:

devenv /updateconfiguration
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Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features,
and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus Customer Care to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Advanced Installation Tasks
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install the additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing on Microsoft Terminal Server and Citrix - available in the product Help and on the Product

Documentation pages on Micro Focus Customer Care

See this information on the Product Documentation pages on Micro Focus Customer Care, in the product
help for Visual COBOL for Visual Studio 2022 (click here).

On Windows

Installing as an Upgrade
• This release cannot be installed as an upgrade to an earlier release of Visual COBOL. You must

uninstall the previous version before installing 9.0.

Visual COBOL Installation Options
To install Visual COBOL you run vcvs2022_90.exe which contains a number of product .msi files
(Windows Installer packages). When run, vcvs2022_90.exe performs some initial system checks then
sequentially installs the .msi files.

vcvs2022_90.exe can take a number of parameters, enabling you to specify a number of different types
of installation:

• Standard Installation

Format:
vcvs2022_90.exe

Summary:
Full installation including License Manager and Visual COBOL. During installation you can specify
options including the location to which the components are installed.

• Non-standard Installation 
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Format:
vcvs2022_90.exe skipmstools=1

Summary:
Full installation, minus the Microsoft package dependencies. A standard installation downloads and
installs the latest Windows SDK packages. Refer to Microsoft Package Dependencies to see if you
will depend on these packages, and if not, use the option above to skip installation of the packages,
thus reducing the footprint and duration of the installation process.

• Non-interactive Installation

Format:
vcvs2022_90.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
start /wait vcvs2022_90.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
start /wait vcvs2022_90.exe /q InstallFolder=d:\otherdirectory

Summary:
Full installation, but the components are installed non-interactively with no user interface, and Visual
COBOL is installed to d:\otherdirectory.

To see what parameters you can use, execute the following from the command line:
vcvs2022_90.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus Customer Support Documentation Web

site for any documentation updates.

On Windows

Starting the Product
You are now ready to run Visual COBOL:

Windows 10 • From your Windows desktop, click Start > Visual Studio 2022.
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Windows 11 • Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start Visual Studio 2022.

Managing the Microsoft Build Tools and Windows SDK Packages
There are a number of COBOL development features that depend on the Microsoft Build Tools and
Windows SDK packages. By default, the product installer downloads and installs these packages to their
default locations. The installer then sets your COBOL environment to depend on those downloaded
versions.

You can use the Microsoft Build Tools and Windows SDK Packages configuration utility - cblms - to view
which versions are in use, and also configure your COBOL environment if you require something other
than the standard usage.

For example, some project types (for example, .NET projects) require a different version of the Microsoft
Build Tools (the Visual Studio 2019 version) than the one installed (the Visual Studio 2017 version). If you
have already installed the correct version for .NET, run cblms after product installation, to update your
environment to use the correct package.

There is an option within the product installer to skip the installation of the default packages
(skipmstools=1); however, this does skip both packages, so make sure that you do already have the
package(s) that you require before setting this - see Microsoft Package Dependencies for details on the
package(s) you may require.

The Microsoft Build Tools and Windows SDK Configuration Utility

Use the cblms command line utility to view and set the package versions in effect for your COBOL environment.

Important: If you are updating or clearing package versions, you must run this utility from a command
prompt with administrative privileges.

Syntax:
cblms <option>

Parameters:

Note: <option> settings are case insensitive.

<option> can be one of:

-U
Updates the COBOL environment to use the latest versions of the Microsoft Build Tools
and SDK packages that are located in the default folders. Any open IDE instance or
command prompt must be restarted before these changes take effect.

-U<ms-pkg>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the default folder. Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the default folder.Any open IDE instance or command prompt must be
restarted before these changes take effect.

-U<ms-pkg>:<path>
Updates the COBOL environment to use the latest version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.
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-U<ms-pkg>:<path>?<version>
Updates the COBOL environment to use a specific version of the particular package type
that is located in the (non-default) folder specified. Any open IDE instance or command
prompt must be restarted before these changes take effect.

-L
Lists all versions of the Microsoft Build Tools and SDK packages that are located in the
default folders.

-L<ms-pkg>
Lists all versions of a particular package type that are located in the default folder.

-L<ms-pkg>:<path>
Lists all versions of a particular package type that are located in the (non-default) folder
specified.

-Q
Displays the versions currently in use by the COBOL environment.

-Q<ms-pkg>
Displays the version of the selected package type that is currently in use by the COBOL
environment.

-R
Clears all version information. (Only use this option when instructed to by Customer Care.)

-H
Displays the available command line options.

Legend:

<ms-pkg> <ms-pkg> can be one of S or SDK for the Microsoft SDK, or B or BT for the Microsoft Build
Tools.

<path> <path> is the path in which to locate packages that are not installed to the default location for
their package type.

<version> <version> is the package version with which to update when the latest version is not the one
required. When specifying version, it must be in the form:

• n.n.n.n for a Windows SDK
• n.n.n for Build Tools
• n for list ID - the list ID is displayed using cblms -L.

The following example updates the COBOL environment to use version 10.0.17134.0 of
the Windows 10 SDK, installed in C:\WinSDK\10.

cblms -USDK:C:\WinSDK\10\10.0.17134.0

Viewing the Product Help
Visual COBOL is configured to display the product help available online on the Micro Focus Customer Care
website: https://www.microfocus.com/support-and-services/documentation/.

You can view the product help in one of the following ways:
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Online help (default)

Note:

• Your Visual Studio must be configured to show online help by default. Make sure Help > Set Help
Preferences in Visual Studio points to Launch in Browser.

• Ensure that you have an up-to-date version of your browser.

You can access the Help in one of the following ways:

• Click Help > Micro Focus Product Help > Product Documentation.
• Alternatively, press F1 inside the editor or from a UI part.

This opens the Visual COBOL help or Microsoft's MSDN depending on which keyword in the editor or
part of the UI you are querying.

Local help

Note: If you've had an earlier version of Visual COBOL installed on your machine, you need to
uninstall any older version of the documentation as follows:

1. Click Help > Add and Remove Content inside Visual Studio.

This starts the Microsoft Help Viewer.
2. Click the Manage Content tab and click Disk.
3. Click Remove next to the line for the Visual COBOL documentation.
4. Click Update.

The local help is not shipped with the installer. If you prefer to view the help locally on your machine, you
need to download and install it manually as described below.

1. Download the local help files:

a. Find the download link for local help in your Electronic Product Download email or in the Product
Updates section on the Micro Focus Customer Care website and save the files on your machine.

b. Expand the archive on your machine. Ensure that the .msha and the .cab files are in the same
folder.

2. Ensure that the Visual Studio Help Viewer is installed:

a. Click Help inside Visual Studio.

If no View Help command is available, you need to install the Help Viewer manually. See Installing
missing components of Visual Studio in Software Requirements for instructions on how to install it.

3. Install the help in the Help Viewer:

a. Click Help > Add and Remove Content inside Visual Studio.

This starts the Microsoft Help Viewer.
b. Click the Manage Content tab and click Disk.
c. Click the browse button next to Disk and navigate to the folder in which you extracted the local help

files.
d. Select helpcontentsetup.msha and click Open.

This loads the Visual COBOL documentation.
e. Click Add and then Update.

After the installation is complete, the Visual COBOL product Help appears in the Help Viewer.
4. Configure Visual Studio to use local help:

a. Start Visual Studio.
b. Ensure that the Visual Studio Help Library is pointing to local help - from the Visual Studio menu

click Help > Set Help Preferences > Launch in Help Viewer.
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c. Click Help > View Help.

This opens the product help in Microsoft's Help Viewer.

For full details of the Visual Studio Help system, see the MSDN.

Note: On some Windows versions, an issue with Microsoft Help Viewer and Internet Explorer's
security being turned on can cause the Help content to be displayed as raw HTML code. To
resolve the issue, you need to turn off the Internet Explorer Enhanced Security Configuration
(IE ESC) for both administrators and users. Check the Microsoft Windows help for more
information on how to do this.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

Important: Before performing a repair of the installation, Micro Focus recommends that you create
backups of any configuration files of the product that you might have changed.

To repair your installation:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

During the uninstall process, only those files added during the installation (to the installation and Samples
directories) are removed. If the installation installed the Microsoft Windows 10 SDK or Microsoft Build Tools
packages, these are left in place, although the Micro Focus-related registry entries for these packages are
removed.

If the product directory has not been removed, delete any unwanted files and subdirectories within it using
Windows Explorer.

Note: The installer creates separate installations for Micro Focus Visual COBOL Micro Focus
Analysis Services Integration, and Micro Focus License Administration. Uninstalling only Visual
COBOL does not automatically uninstall the Micro Focus License Administration or any of the
prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.
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To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile
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Licensing Information
Note:

• Personal Edition licensing is only available with Visual COBOL for Visual Studio 2022.
• When you activate Visual COBOL Personal Edition, you can use it for a limited period of 365 days.

After this period, you can either register a new Personal Edition license for 365 days or acquire a
valid full license of Visual COBOL in order to continue using the product.

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus Customer Care.

Important: The SafeNet Sentinel licensing system has been deprecated and will be not available in
this product starting with the next major release - release 10.0.

The SafeNet Sentinel licenses will not be supported after release 9.0. You can only use AutoPass
licenses from release 10.0.

You can replace your SafeNet Sentinel licenses with AutoPass licenses starting with release 8.0.
However, it is not necessary to switch to AutoPass licenses unless you are adopting release 10.0.
Contact Micro Focus Customer Care for further information.

To activate Visual COBOL Personal Edition
To activate Personal Edition:

1. Start Visual COBOL.

If you have not installed a license for Visual COBOL, starting the IDE and trying to create a COBOL
project opens the Micro Focus Visual COBOL Product Licensing dialog box. If you cancel this dialog
box, you can invoke it again from Help > Micro Focus Product Help > Product Licensing.

2. Copy the authorization code which you were sent after registering for Personal Edition, and paste it into
the Authorization code field.

3. Click Finish.

You should receive a message that the activation has been successful.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus Customer Care.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.
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To start Micro Focus License Administration

To start the GUI Micro Focus License Administration

Windows 10 From your Windows desktop, click Start > Micro Focus License Manager > License
Administration.

Windows 11 Click the Start button in the Task Bar. Use the search field in the Start menu to find and
start License Administration.

To start the command-line Micro Focus License Administration tool

1. At a command prompt, navigate to:

C:\Program Files (x86)\Micro Focus\Licensing

2. Type cesadmintool.bat, and press Enter.

Installing licenses
You need either a license file (with a .mflic extension for Sentinel RMS licenses or an .xml extension for
AutoPass licenses) or an authorization code which consists of a string of 16 alphanumeric characters
(Sentinel RMS licenses only). You need to install AutoPass licenses into the existing Micro Focus License
Administration tool, and not in the AutoPass License Server.

If you have a license file

To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic or .xml).

• Drag and drop the license file from Windows Explorer to the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.

If you have not installed a license for Visual COBOL, trying to use the Micro Focus functionality for the
first time after you install the product results in a warning message. Visual Studio displays an
information bar with a message that Visual COBOL does not have a valid license. You can use the
Install license link in the bar, or close the bar.

2. Click Help > Micro Focus Product Help > Product Licensing to open the Product Licensing dialog
box.

3. Click Browse next to the License file field.
4. Select the license file (which has an extension of either .mflic or .xml), and then click Open.
5. Click Authorize to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.
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To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Manual License Installation option by entering 4.
3. Enter the name and location of the license file.

If you have an authorization code
Note: Authorization codes are only available with Sentinel RMS licensing.

Authorizing your product when you have an Internet connection
Note:

• This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

To use the command-line Micro Focus License Administration tool

1. Start the command-line Micro Focus License Administration tool.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code. Authorization codes are only available
with Sentinel RMS licensing.

This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

To use the GUI Micro Focus License Administration

1. Start Micro Focus License Administration.
2. On the Install tab, click Manual Authorization.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the Customer Care Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.
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The Micro Focus Customer Care Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

To use the command-line Micro Focus License Administration tool

In order to authorize your product from the command-line Micro Focus License Administration tool you
must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by entering 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

entering 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus Customer Care.
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Updates and Customer Care
Our Web site provides up-to-date information of contact numbers and addresses.

Further Information and Customer Care
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• Product Updates on Software Licenses and Downloads, where you can download fixes and
documentation updates.

1. Log into the Software Licenses and Downloads (SLD) site at https://sld.microfocus.com/mysoftware/
download/downloadCenter .

2. Select your account and click Entitlements.
3. Search for the product by using any of the available search parameters.
4. Click Show all entitlements.
5. Click Get Software in the Action column for the product you want to download or update.

In the File Type column, you see entries for "Software" for any GA products, and "Patch" for any
patch updates.

6. Click Download on the relevant row.
• The Examples and Utilities section of the Micro Focus Customer Care Web site, including demos and

additional product documentation. Go to https://supportline.microfocus.com/examplesandutilities/
index.aspx.

• The Support Resources section of the Micro Focus Customer Care Web site, that includes
troubleshooting guides and information about how to raise an incident. Go to https://
supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com/en-us/home/ in your browser to go to the Micro Focus home
page, then click Support & Services > Support. Type or select the product you require from the product
selection dropdown, and then click Support Portal.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from
another source, such as an authorized distributor, contact them for help first. If they are unable to help,
contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See https://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product. See Micro Focus Channel on
YouTube.

• Micro Focus webinars: https://www.microfocus.com/en-us/resource-center/webinar.
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Information We Need
If your purpose in contacting Micro Focus is to raise a support issue with Customer Care, you should
collect some basic information before you contact us, and be ready to share it when you do.

See the Preparing to Raise a Support Case topic on the Product Documentation pages on Micro Focus
Customer Care, in the product help for Visual COBOL for Visual Studio 2022 (click here).

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus Customer
Care, your support representative might request that you provide additional debug files (as well as source
and data files) to help us determine the cause of the problem. If so, they will advise you how to create
them.
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Copyright and Disclaimer
© Copyright 2023 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party Web sites take you outside Micro Focus Web sites, and Micro Focus has no control
over and is not responsible for information on third-party sites.
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